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Read Me First
 
Welcome to Take Control of Speeding Up Your Mac, version 1.0, 
published in May 2011 by TidBITS Publishing Inc. This book was 
written by Joe Kissell and edited by Adam Engst. 

Don’t settle for a sluggish Mac! This comprehensive book teaches 
you how to find the exact causes of slow performance and take steps 
to make your Mac snappy and responsive. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to 
buy a new copy to read it more carefully or to keep it for reference. 
Discounted classroom and Mac user group copies are also available. 

Copyright © 2011, Joe Kissell. All rights reserved.
 

Updates and More
 

You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end of the book; it’s available only to 
purchasers). On the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and—usually— 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

•	 Read postings to the ebook’s blog. These may include new 
information and tips, as well as links to author interviews. At the 
top of the blog, you can also see any update plans for the ebook. 

•	 Get a discount when you order a print copy of the ebook. 
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Basics
 

Here are a few “rules of the road” that will help you read this book:
 

•	 Menus: Where I describe choosing a command from a menu 
in the menu bar, I use an abbreviated description. For example, 
to create a new folder in the Finder, you choose New Folder from 
the File menu; I abbreviate this by saying “File > New Folder.” 

•	 Contextual menus: In Mac OS X, when you hold down the 
Control key and click, a pop-up contextual menu appears, with 
commands appropriate to whatever is under the mouse pointer. 
For example, if you Control-click a file in the Finder, you’ll see 
commands such as Get Info, Duplicate, and Make Alias. Control-
clicking nearly always works to open a contextual menu, but your 
mouse or trackpad might support a better method. The default 
behavior, the alternative methods, and the ways to set them vary 
depending on the type of input device; the typical alternative (for 
right-handed users) is to right-click with a mouse—click the right-
hand mouse button—so that’s the term this book uses by default 
for the action that opens a contextual menu. 

•	 Finding System Preferences: I sometimes refer to settings in 
System Preferences that you may want to adjust. To open System 
Preferences, click its icon in the Dock or choose Apple  > System 
Preferences. When the System Preferences window opens, click the 
icon of the pane whose settings you want to adjust. I refer to these 
panes using an abbreviated notation such as “the Network 
preference pane.” 

•	 Finding an application’s preferences: I often refer to 
preferences in an application that you may want to adjust. Don’t 
confuse an application’s preferences with the system-wide settings 
found in System Preferences. To access an application’s preferences, 
choose Application Name > Preferences. For example, in the 
program Disk Utility, you would choose Disk Utility > Preferences. 

•	 Path syntax: This book occasionally uses a path to show the 
location of a file or folder in your file system. For example, Mac 
OS X stores most utilities, such as Terminal, in the Utilities folder. 
The path to Terminal is: /Applications/Utilities/Terminal. 
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The slash at the beginning of the path tells you to start from the root 
level of the disk. You will also encounter paths that begin with ~ 
(tilde), which is a shortcut for the user’s home directory. For 
example, if a person with the user name joe wants to install fonts 
that only he can access, he would install the fonts in his ~/Library/ 
Fonts folder, which is just another way of writing /Users/joe/ 
Library/Fonts. 

•	 Disks and drives: Not so long ago, every Mac came with a hard 
disk as its main data storage device. These days, one can no longer 
assume that; a new Mac you buy today might have one or more hard 
disk drives, one or more solid-state drives (SSDs), or a combination 
of the two. In this book, I frequently use the term disk to refer to 
your Mac’s main storage device, regardless of the technology it uses; 
when my instructions vary depending on whether that device is a 
mechanical hard drive or an SSD, I spell out those differences. 

•	 Big cats: I frequently mention features specific to a particular 
version of Mac OS X, which Apple usually refers to by a “big cat” 
code name: 

‣	 Lion: Mac OS X 10.7 

‣	 Snow Leopard: Mac OS X 10.6 

‣	 Leopard: Mac OS X 10.5 

‣	 Tiger: Mac OS X 10.4 

‣	 Panther: Mac OS X 10.3 
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Introduction
 
Tell me if this sounds familiar. You get a new Mac, and your initial 
impression is “Wow! So fast!” Everything seems so snappy compared 
to that old computer you were using before. Without even thinking 
about it, you find yourself opening more applications and documents 
than you ever could, and it all just works. Everything you do—playing 
games, running Photoshop filters, searching your massive email 
archive—seems to happen almost instantly. 

But as time passes, a funny thing happens. You begin to notice, every 
now and then, that something takes a bit longer than it used to. 
Gradually, those occasions become more frequent. Then you become 
aware of other strange behavior. Video that used to play smoothly now 
stutters. Web pages seem to take forever to load. Opening applications 
and saving files is oddly time-consuming. That cursed spinning wait 
cursor (see the sidebar The Spinning Pizza of Death) may rear its ugly 
head from time to time. And you dread the thought of having to restart 
your Mac, because it takes an unbearably long time. 

This sort of thing happens to just about everyone, although the severity 
and the rate at which these slowdowns occur vary from one situation 
to the next. Likewise, it’s not at all uncommon for a Mac to encounter 
spontaneous or intermittent performance problems rather than a slow 
degradation of speed. So you’re not alone, but that may be cold 
comfort; your Mac is still too slow! What to do? 

Of course Apple would like you to hand them lots of money for a new 
Mac—and sooner or later that will indeed turn out to be necessary. But 
take heart: you can reverse the effects of time and return your Mac to 
its formerly zippy self. (And, if you have a newer Mac that’s still pretty 
fast, you can squeeze even more power out of it!) 

But here’s the problem. There are hundreds, maybe thousands, of 
books, articles, blog posts, Web pages, and utilities that purport to 
speed up your Mac. I’ve spent countless hours researching these 
claims, and I’m sorry to say the vast majority of them are wrong. By 
“wrong” I mean incomplete at best, dangerous at worst, and nearly 
always based on guesses, anecdotes, or outdated information rather 
than, you know, verifiable facts. 
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Many of these claims have a bit of truth to them, so it’s easy for even 
very smart people to be misled. For example, a friend told me her Mac 
had become terribly slow, and she’d done some research that led her 
to believe she needed a larger hard drive. Her disk was within a hair’s 
breadth of being full, and it’s true that a full disk can make your Mac 
very slow. So without any further experimentation I agreed with her 
analysis. She bought a new hard drive—a big expense in her case—and 
I installed it for her. But a week later my friend told me with great 
frustration that her Mac didn’t feel any faster, even if her new disk did 
have plenty of breathing space. She was enormously disappointed, and 
although she didn’t want to impose on me by asking me to do further 
troubleshooting, I later learned that her next computer was a PC. 

I bear much of the blame for her dashed expectations. I jumped to a 
conclusion, and I should have known better. We did indeed solve a 
problem by installing a larger disk, but that didn’t happen to be the 
major factor contributing to her Mac’s poor performance. 

Maybe you’ve had a similar experience. Perhaps you tried something, 
or a dozen things, that should have worked—or that did indeed work 
for other people. But your Mac is still slow. 

So let’s put all the conventional wisdom and guesswork behind us and 
turn to science. My aim in this book is to be systematic, factual, and 
testable. I explain the factors that affect a Mac’s speed and how they 
interact. I tell you what to check, and what steps you can take to solve 
various speed problems. But crucially, I also show you how to verify 
numerically if or how much a certain change speeds things up. You 
don’t have to take my word for it that some procedure may improve 
your performance—and you don’t have to rely on informal perceptions 
either. You can measure your Mac’s speed yourself, before and after 
making changes, and then you’ll know for sure whether it’s better. And 
if it’s not, you’ll have the tools and knowledge you need to try another 
technique, and another, until you’ve found and solved the problem. 

I hope that little pep talk has inspired and encouraged you—you can 
and will make your Mac faster! At the same time, I want you to set your 
expectations correctly. You can make your Mac as fast as the day you 
bought it—and in many cases even push it well beyond that—without 
having to wipe your hard disk and start from scratch. But you’re not 
going to make a ten-year-old G4 run as fast as a brand-new Intel-based 
Mac. 
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In particular, I want to be sure you understand the following:
 

•	 The world changes. Even if you returned your Mac to its exact 
physical state at the time you purchased it, you may find that 
some things are slower because of factors outside your control— 
for example, a Web site that used to be text-based and speedy may 
have switched to Flash and gotten slower. You feel the effect on your 
Mac, but it’s not your Mac’s fault. 

•	 You may have to accept trade-offs. Say your Mac shipped 
with Mac OS X 10.4 Tiger, and you upgraded it so that it now runs 
10.6 Snow Leopard. Newer versions of Mac OS X (and of third-party 
applications) may add terrific features that you’ve come to depend 
on, but also require greater system resources to run, which may tax 
older hardware. So it could be that you must decide between speed 
and features—or make some other unpleasant choice. 

•	 Returns diminish. You’ll do some easy things that speed up your 
Mac quite a bit, but as you progress through the book, you may find 
yourself spending more and more time for ever smaller speed gains. 
There comes a point at which it simply isn’t worth any more bother. 

•	 It could cost you. Many of the techniques in this book can be 
performed for free, but if you want to make your Mac as fast as 
possible, you may need to invest in software, hardware, or both. 

When I wrote the first edition of Take Control of Troubleshooting 
Your Mac, I treated slow performance as a minor problem and 
devoted a mere three pages to it. Similarly, although Take Control 
of Maintaining Your Mac overlaps a bit with what I discuss here, it 
focuses on preventing problems rather than curing them. The advice 
I give in those other books is useful, of course, but I realized after 
considerable feedback from readers that it didn’t even begin to scratch 
the surface of the speed issue. So my hope is that the book you’re now 
reading will do far more than that—it should give you, by the time 
you’re done with it, a much faster Mac with a new lease on life. 

Most of the advice I give here should work regardless of which version 
of Mac OS X you’re running, but it’s mainly geared toward users with 
10.4 Tiger or later. Although 10.7 Lion has not yet been released as I 
write this and developers with early access are bound by nondisclosure 
agreements, I’ve included a few Lion-specific details that had already 
been made public in one way or another. 
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Speeding Up Your Mac 
Quick Start 
Many factors can influence a Mac’s speed, including some that 
may not be obvious. So I encourage you to read and follow all the 
steps in this book. Although I’ve tried to present tasks in a logical 
progression for the most part, the order in which you do things 
is not critical. But please be sure to read Learn What Makes a Mac 
Fast (or Slow) first to get important background information; follow 
the steps in Try a Few Quick Fixes regardless of the problems you’re 
experiencing; and acquaint yourself with the test procedures in 
Diagnose Common Speed Problems, since I refer to them again and 
again in the remaining chapters. 

Start on the Right Foot 
•	 Get a grip on the underlying issues; see Learn What Makes a Mac 

Fast (or Slow). 

•	 Solve several common speed problems in minutes; see Try a Few 
Quick Fixes. 

•	 Learn about test procedures, benchmarking, and monitoring 
resource usage; see Diagnose Common Speed Problems. 

•	 Clean up gremlins on your disk that can have numerous cascading 
effects; see Fix File and Directory Problems. 

Solve General Speed Problems 
•	 Make sure your CPU isn’t burdened with unnecessary tasks; see 

Lighten Your CPU Load. 

•	 Prevent low-memory situations from slowing down your Mac; see 
Increase Your Free RAM. 

•	 Get data onto and off of your disk faster and more efficiently; see 
Improve Your Disk Performance. 

Speed Up Specific Applications and Activities 
•	 Surf faster; see Speed Up Your Browser. 
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•	 Avoid aggravating delays when using Mail, Entourage, or Outlook; 
see Speed Up Your Email. 

•	 Test and optimize all the links between your Mac and an outside 
server; see Speed Up Your Network. 

•	 Help your Mac get up and running faster; see Speed Up Booting, 
Sleeping, and Waking. 

•	 Save time with utilities and tricks to increase input efficiency; see 
Speed Up Mouse and Keyboard Input. 

Address Hardware Issues 
•	 Replace or add hardware components for increased performance; 

see Upgrade Your Hardware. 

•	 Eliminate USB and FireWire bottlenecks; see Speed Up Your 
Peripherals. 
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Learn What Makes a Mac 
Fast (or Slow) 
In this chapter I try to set the record straight about what does and 
does not influence your Mac’s speed. Unfortunately, slowdowns 
are often treated as a sort of voodoo topic where users are urged to 
simply Perform the Magical Procedure but with no explanation of 
what it really does or why it should work. There are a lot of myths 
floating around; most of them do have an element of truth to them, 
but that truth is often more constrained or specific than you may 
have been led to believe. Hence, this overview of the positive factors 
involved, followed by a rogue’s gallery of purported fixes for slow 
Macs that usually do very little good, if any. 

The Three Most Important Determiners 
of Mac Performance 

As you’ll see throughout this book, lots of factors contribute to your 
Mac’s performance. If your Mac is too slow, it may be due to one 
specific cause (and perhaps not the most obvious one), or it could be a 
combination of things. But in my experience, three main factors—CPU 
power, RAM, and disk speed—exert a greater influence a Mac’s overall 
performance than anything else. Because many of the steps I describe 
in this book are intended to address one or more of them, I want to 
be sure you understand why and how they affect your Mac’s speed. 

CPU Power 
Your Mac has one or more central processing units (CPUs)—the 
computer’s “brains.” The CPU is where all the calculations happen 
that enable your Mac to do everything from displaying a single dot 
on the screen to surfing the Web and editing video. Since calculations 
are what a computer is all about, it stands to reason that the more CPU 
power you have, the faster your computer will be. However, in this case 
“power” is a slippery notion, and direct comparisons between Macs 
with different sorts of CPUs get tricky. Several factors come into play. 
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Number of CPUs 
If one brain is good, two brains are better! Having more than one CPU 
means your Mac can process more tasks at the same time. There isn’t 
a one-to-one correlation between number of CPUs and speed—a two-
CPU Mac won’t be exactly twice as fast as an otherwise identical single-
CPU Mac—because other factors come into play. For example, if a 
certain operation depends heavily on disk access, the disk speed could 
become the bottleneck, regardless of how many CPUs are available. 
And software must be specially designed to take maximum advantage 
of multiple CPUs. 

Tip: To find out how many CPUs and cores your Mac has, open 
System Profiler (in /Applications/Utilities), select Hardware in 
the list on the left, and look at the “Total Number of Processors” 
and “Total Number of Cores” lines, respectively. 

Number of Cores 
Each CPU chip has one or more cores—the parts of the CPU that do 
the actual computations. Having more cores gives you more processing 
power, because your Mac can do more calculations at any given time. 

The PowerPC CPUs used in older Macs have just one core each, but 
most Intel-based Mac models use multi-core CPUs. For a while, dual-
core Intel CPUs were the big thing, then quad-core chips started 
appearing, and now hexacore (6-core) chips are becoming the new 
black. Meanwhile, Intel is already shipping CPUs with eight cores, 
which are bound to make their way into Macs before long—and chips 
with as many as 80 cores have been produced (though these are 
expensive chips used mainly in high-end scientific work). 

As with independent CPUs, there isn’t a linear relationship between 
the number of cores and a Mac’s speed—a four-core CPU won’t be 
exactly twice as fast as one with two cores. (By the way, depending on 
several variables, multiple cores yield performance that’s sometimes 
a bit faster, and sometimes a bit slower, than an equivalent number of 
independent CPUs.) And, as with multiple CPUs, not all software can 
exploit multiple cores effectively, so performance may vary from one 
application to the next. 
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Try a Few Quick Fixes
 
Lots of the procedures in this book require time, thought, and effort 
to understand and put into practice. I hope that you’ll be systematic 
about testing speed before and after making changes (as I describe 
later in Understand Diagnostic Principles), because I think the 
results are worth it. But that testing might take hours, and 
meanwhile you’ll still be struggling with a slow Mac. 

Fortunately, in many cases you can make significant improvements 
to your Mac’s performance in a few minutes, and with hardly any 
effort. What I describe in this chapter may not be a complete or 
permanent solution, but it’s the best and easiest place to start. 

In fact, even if you plan to work your way carefully through every 
single procedure in this book, you should start with the items in this 
chapter—they won’t hurt, they might help, and if nothing else they 
give your further tests a better foundation. 

Restart Your Mac
 

If your Mac is running slower than usual, the very first thing you 
should do is restart it (choose Apple  > Restart). Merely restarting 
solves several kinds of problems: 

•	 It forces all applications and background processes to quit, 
including any that may be chewing up CPU cycles or otherwise 
causing problems. 

Process this: The term process refers to a program that’s 
currently running—not only an application you’ve launched 
yourself, but also any of numerous parts of Mac OS X and third-
party programs that may be active at any given time, possibly 
without displaying any visible user interface. 

•	 It frees up RAM, giving Mac OS X and applications more room to 
work when your Mac starts up again. 
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•	 It deletes certain temporary files on your disk, including virtual 
memory swap files—this can increase speed when you’re critically 
short on disk space. 

In many cases, restarting brings your Mac immediately back to its 
normal zippy state. It may not stay that way, of course; the very things 
that slowed down your Mac in the first place can—and probably will— 
happen again. (Don’t worry, we’ll get to those too.) But restarting is the 
easiest way to jolt your Mac back to life, at least temporarily. 

Using Safe Mode 

Mac OS X includes an extremely useful diagnostic feature called Safe 
Mode (also known as Safe Boot, since it’s a way to boot your Mac) 
that disables a number of components that would otherwise load at 
startup or login; it also performs a few low-level cleanup tasks. For 
those of you who remember using Mac OS 9, this is the modern-day 
equivalent to booting with extensions off. 

To use Safe Mode—that is, to perform a Safe Boot—first turn off 
your Mac. (Seriously: don’t just restart. Choose Apple  > Shut 
Down or press the power button, and click Shut Down in the dialog 
that appears.) Turn your Mac on again, holding down the Shift key 
until the Apple logo appears; then release the Shift key and let your 
Mac start up the rest of the way. Despite the fact that it disables 
software, a Safe Boot takes longer than a normal boot because of 
the aforementioned cleanup tasks, so be patient. 

To learn more about Safe Mode, see Apple’s official description, 
located at http://support.apple.com/kb/ht1564. 

Apple’s description doesn’t mention, however, that Safe Mode uses 
much more RAM than a normal boot, or that running your Mac in 
Safe Mode results in severely decreased performance (as measured, 
for example, by benchmarking tools). As a result, you can’t use Safe 
Mode to make meaningful judgments about the extent to which 
startup and login items slow down your Mac. 
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Diagnose Common 
Speed Problems 
Saying “My Mac is slow” is like going to the doctor and saying, 
“I feel yucky.” You won’t get anywhere with a cure—or even a 
diagnosis—unless you can be much more specific. So in this chapter 
I help you to figure out exactly which aspects of your Mac are too 
slow (so I can direct you to appropriate fixes), and actually measure 
how slow (so we can measure again afterward and determine how 
effective the fixes were). 

We’ll work from general to specific. First, I explain the basic 
diagnostic principles you’ll use throughout the book. Next, I show 
you how to benchmark your Mac’s raw performance so you have 
a baseline against which to compare future results—something you 
should do regardless of what particular speed problem you’re trying 
to solve. Then I discuss tools that provide a real-time display of how 
various system resources are being used at any given moment, 
which helps you identify software that may be slowing you down. 
Finally, I provide links to tests described elsewhere in this book that 
help you narrow down several specific speed problems. 

Understand Diagnostic Principles
 

Something has gone wrong. Your car has stopped moving, or your foot 
hurts, or your Mac is too slow. You want to solve the problem, but you 
can’t do that without understanding the cause. Sometimes it’s obvious: 
your gas gauge is on empty, there’s a rock in your shoe, or you’re trying 
to rip a DVD while cloning your hard disk and playing a game. But 
when it’s not obvious, it helps to have general techniques to figure out 
the source of the problem so you can choose an appropriate solution. 

One of the most powerful diagnostic techniques, which can be used 
to find problems with nearly any complex system, is to change just 
one thing and check whether the problem still exists. This technique 
isn’t foolproof; problems might have multiple causes, and sometimes 
several factors interact in ways that are difficult to pin down. But it’s 
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an excellent starting point. If you try changing three things and the 
problem goes away, you won’t know whether one, two, or all three of 
those things caused the problem. So, I recommend that you internalize 
the following sequence of steps, which you’ll follow many times: 

1. To the extent possible, eliminate extraneous factors that could affect 
your test. 

For example, if you’re using your Web browser to test the speed 
of your Internet connection, quit other programs and background 
processes using your network, because they could skew your results. 

2. Measure the speed of some activity—and make a note of it for future 
reference. 

3. Change one thing that might affect that speed. 

4. Measure the speed again. 

Then, if the problem still exists—that is, the speed hasn’t increased 
noticeably—repeat the steps, changing something different in Step 3. 
(Depending on the situation, you may choose to return the thing you 
changed in Step 3 to its original state before performing the next test, 
but in the absence of evidence to the contrary, your default assumption 
should be that if the tests in steps 2 and 4 showed the same result, then 
whatever you changed in Step 3 was irrelevant to the slowdown.) 

Once you have this basic outline down, the only things that remain to 
learn are how to measure speed (which I discuss in the remainder of 
this chapter) and which items to try changing in Step 3 (which I 
discuss throughout the book). 

Alert readers may recognize the procedure I’ve just described as a 
simplified version of the scientific method: form a hypothesis, conduct 
an experiment to test the hypothesis, analyze the results, and then 
if necessary start over with a revised hypothesis. In diagnosing Mac 
slowdowns, as in science generally, the best-designed experiments 
isolate and test just one variable. 
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Fix File and 
Directory Problems 
Although less common than many people imagine, it’s possible for 
things like corrupted fonts, caches, and preference files to result, 
somewhat indirectly, in a slow Mac. Similarly, disk errors of various 
sorts, such as directory damage, can result in a slower Mac (not to 
mention causing other problems). 

Fortunately, the majority of file and directory problems are easily 
solved—as long as you have the right tools and know how to use 
them. Because these sorts of problems can affect everything your 
Mac does, you should check for, and repair, file and directory issues 
before moving on to the more specific steps I cover in later chapters. 

Run Disk Utility
 

Disk Utility, included with every Mac, can repair a variety of disk 
errors. Most of these problems have nothing to do with speed as such, 
but some can lead, even if indirectly, to slow performance—and in any 
case, they’ll cause you headaches of one kind or another. So, before 
you continue with other tasks in this book, I recommend, on general 
principle, using Disk Utility to check for and repair disk errors. 

To repair your disk, follow these steps: 

1. Start up your computer from media—other than your regular 
startup disk—that also contains Disk Utility. This could be, for 
example: 

‣	 A bootable duplicate of your startup disk stored on an external 
FireWire (or, for Intel-based Macs, USB) hard drive, a second 
internal drive, or a second partition of your main disk 

‣	 A Mac OS X installation DVD or CD 

‣	 The USB Software Reinstall Drive included with certain Macs 
(such as the MacBook Air and the Mac mini server) that lack 
an optical drive 
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Outside in: You can’t repair the disk from which Mac OS X is 
running (or the disk from which Disk Utility is running, if it’s not 
the same one); that would be somewhat like trying to perform 
brain surgery on yourself. 

2. Run Disk Utility: 

‣	 If you are running from a cloned hard disk, you can find Disk 
Utility in /Applications/Utilities. 

‣	 If you’re running from a Mac OS X installation disc, click 
through the installer’s language selection screen—don’t worry, 
this won’t actually start to install Mac OS X—and then choose 
Utilities > Disk Utility. 

3. In the list on the left side of the window, select your main startup 
volume (the one you want to test), as in Figure 7. 

Figure 7: Select a volume (other than the startup volume) on the 
left, and then click Repair Disk. 

4. On the First Aid pane, click Repair Disk. 
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Lighten Your CPU Load
 
As I discussed in CPU Power, your CPU is responsible for doing all 
the actual computations involved in making your Mac run. As a 
result, when your CPU is being pushed close to its limit, your Mac 
will slow down, and the way to speed it back up is to reduce some of 
the demands on your CPU so it can devote its power to the activities 
that are most important to you. 

In this chapter I focus on steps you can take to reduce excess CPU 
usage. Because any process that uses CPU power also uses some 
RAM and, in most cases, accesses your disk, stopping or throttling 
that process can improve all three aspects of your Mac’s 
performance. The items I discuss in this chapter are those for 
which, in my judgment, the improvements to CPU load tend to 
outweigh improvements in RAM usage and disk access. 

Cut Back on Startup and Background Items 

Earlier in this book (see Prune Login Items), I suggested removing 
any extraneous applications from your Login Items list—partly because 
they can increase the delay between when you start your Mac and 
when you can get to work, and partly because they may use extra CPU 
cycles and RAM that you might wish to reserve for more important 
tasks. The same is true of startup items (which launch as Mac OS X 
starts, before any user logs in) and a variety of background items that 
load on startup but may not actually become active until later on (see 
the sidebar Launchd and the Meaning of “Start”, just ahead). 

Sometimes, these pieces of software can be tricky to find and remove, 
because a “startup item” can be any of numerous types of software, 
stored in several locations on your disk. But the fact that software 
loads at startup doesn’t in any way mean it’s bad; determining which 
startup items, if any, should be removed will depend on the particulars 
of your setup—whether the strain an item places on your system 
outweighs its usefulness to you. 
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Launchd and the Meaning of “Start” 

A Mac OS X component called launchd (“launch daemon”) is 
responsible for running many other processes in response to a 
particular condition—for example on startup or login, on a fixed 
schedule (such as once a day), or if a certain event (such as 
modifying a file) occurs. Launchd learns what it’s supposed to 
do by reading specially formatted files found in these locations: 

✦ /System/Library/LaunchAgents 

✦ /System/Library/LaunchDaemons 

✦ /Library/LaunchAgents 

✦ /Library/LaunchDaemons 

✦ ~/Library/LaunchAgents 
I count launchd items as “startup items,” but I must qualify that. 
Launchd loads the daemons (which are system-wide processes) on 
startup, but it loads the agents (which are per-user processes) on 
login. A Safe Boot (see the sidebar Using Safe Mode) disables the 
launchd items in /Library and ~/Library—though not those located 
in /System/Library—along with other startup items, but when you 
disable login items, all the per-user launchd agents still load, 
including those in ~/Library. 

In any case, depending on the instructions in the launchd item, 
loading (being added to the list of actions launchd initiates) doesn’t 
imply running; the process(es) referred to by the launchd item may 
not take action until later. For example, a launchd item associated 
with Time Machine tells it to run once an hour. Until then, the 
backupd (Time Machine) process uses no CPU power or RAM, but 
when it runs, the process can use quite a bit of both. 

Because the effects of launchd items may or may not appear 
immediately after you restart, experiments that seem to either 
implicate or exonerate startup items may be misleading. 

The following are the steps I recommend for finding and cutting back 
on startup items, as I’ve (broadly) defined them: 

1.	 Find your startup and background items. Begin by making 
a list (in your favorite text editor, or even on paper) of your startup 
and background items. Here’s where to look for most of the items 

70 

Click here to buy the full 196-page “Take Control of Speeding Up Your Mac” for only $15!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU71198567198&PT=TRK-0119-SAMPLE


           
          

           
       

            
             

       
             
       

              
              

           

      
  

            
             

                
            

             
              

        

  

      

            
            

            
             

             
             

Increase Your Free RAM
 
As I described in detail in RAM, free RAM correlates strongly with 
speed, and running out of free RAM—which in turn increases virtual 
memory usage—is a major reason for slowdowns. So in this chapter 
I explore ways to keep more of your RAM free. 

The things that free up RAM often reduce CPU usage and disk 
access too, but here I’m looking here at cases where RAM is the 
primary consideration. (For example, a well-written application 
might use virtually no CPU cycles when it’s idle, but still chew up 
RAM, so that puts it in this category.) 

Of course, the best way to increase your free RAM is to add more 
(see Add RAM). But if your Mac won’t hold any more, or if you can’t 
afford to add physical RAM, the steps in this chapter should help. 

Reduce the Number of Open Applications, 
Windows, and Tabs 

Look at your Dock right now. How many applications are open? (Open 
applications are signified by a dot beneath the icon, if your Dock is at 
the bottom of your screen, or next to the icon, if your Dock is on the 
side.) Of these, how many are you actively using? How many have you 
even touched in the last hour? I counseled you earlier to Quit Inactive 
Applications, but here I want to provide a bit more detail and ask you 
to go even further—and to develop some new habits. 

Background information: This chapter refers to ordinary 
applications you open yourself; to learn about quitting background 
processes, see Cut Back on Startup and Background Items. 

Each application you run uses at least a bit of RAM, and although its 
CPU usage may drop to virtually nothing when it’s in the background, 
it continues to use RAM—sometimes a lot of RAM—until you quit it. 
Similarly, every new window or tab you open, whether in the Finder or 
in any other application, requires a chunk of RAM, and that’s true even 
if the application is hidden or the window is minimized to your Dock. 
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So the fewer applications, windows, and tabs you have open, the lower 
your overall RAM usage will be. 

Put it on my tab: As far as your Mac’s RAM is concerned, a tab 
is just another window—even though it may not look like one. Web 
browsers are the best-known examples of applications that use 
multiple tabs, but so do some word processors, email clients, 
development tools, and other applications. 

Tip: I discuss additional techniques for dealing with too many open 
windows and tabs in Web browsers later, in Have Fewer Tabs and 
Windows Open. 

Closing windows and quitting applications is pretty straightforward, 
but I do have a few specific tips: 

•	 Quit and (possibly) reopen: When you quit an application, 
Mac OS X recovers the RAM the application was using. Even if you 
immediately reopen the application, its RAM usage will likely be 
less than it was before, because many applications use increasing 
amounts of RAM as they run but then don’t properly give back what 
they no longer need (see Watch Out for Memory Leaks, ahead). 

•	 Don’t just close: As I mentioned earlier, for many Mac 
applications—especially those that are document-based—merely 
closing the application’s last open window doesn’t necessarily quit 
the program. If there’s still a glowing dot by its Dock icon or if its 
icon appears when you press Command-Tab, the application is still 
running, even without any visible windows. Right-click (or Control-
click) on the Dock icon and choose Quit. 

•	 Watch the clock: Mac OS X makes it easy to open lots of 
applications and keep them running. If you’re low on RAM and 
you notice that you haven’t used a given application in more than 
an hour, consider quitting it. It might take a bit longer to reopen 
it the next time, but you’ll probably more than recover that time in 
increased performance due to the extra RAM. (If you want to speed 
up application opening dramatically, get an SSD—see Add an SSD.) 

•	 Check your preferences: A number of applications can 
optionally reopen at launch whatever windows, tabs, or documents 
were open the last time you used the application. (In 10.7 Lion, this 
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Improve Your Disk 
Performance 
Regardless of the raw speed of your (mechanical) hard disk, if 
lots of processes are trying to read/write at the same time, that’s 
going to seriously dent your Mac’s overall performance—even with 
a fast CPU and lots of RAM. In this chapter, I talk about what some 
of those disk-intensive activities are and how to minimize their 
impact. In addition, since your Mac can run slow if its startup disk 
becomes critically low on free space, I explore numerous ways to 
address that problem. And I discuss a few other ways (of varying 
degrees of utility) to increase a disk’s performance. 

Tame Disk Access
 

Earlier, in Disk Speed, I talked about the fact that your hard disk can 
do only one thing at a time. If you ask it to do two or more things at 
once—reading, writing, or searching files—it can accomplish this only 
by switching back and forth between the tasks rapidly, which slows all 
the tasks down. Even an SSD, which doesn’t suffer from the physical 
constraints of mechanical hard disks, can only read or write data from 
one location at a time, so giving it too many things to do will reduce 
its performance. 

Apart from ordinary file access, Mac OS X often uses your disk to 
store virtual memory swap files. If the software you’re running makes 
demands for memory beyond the physical RAM you have installed, 
Mac OS X moves pages of memory onto and off of your disk as needed. 
As I detailed in RAM, although a little of this may go unnoticed, the 
more heavily Mac OS X is forced to depend on virtual memory, the 
greater the amount of disk thrashing. That will slow down your Mac all 
by itself, but when you combine it with other disk-reading and -writing 
activities, it’s bad news all around—your Mac could freeze up. (And 
the best remedy, of course, is to Add RAM.) 

How might you know if your disk is being overworked? If your Mac has 
a mechanical hard drive, you might hear it clicking and whirring away, 
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depending on where your Mac is located, the type of disk, and the 
ambient noise level. But you can get a better idea if you Use Activity 
Monitor. Click Disk Activity at the bottom of the window, and you’ll 
see a graph with reading activity shown in green and writing shown in 
red. In normal use, both of these spike from time to time, and if you’re 
reading a large file (such as playing a movie in iTunes) or writing a 
large file (for example, saving an iMovie project), one or the other 
might stay high for a while. But if you’re seeing sustained high reading 
and writing activity with no obvious cause, you’ll need to dig deeper 
to< discover why it’s happening and what to do about it. I give some 
suggestions in the pages that follow. 

Where’s the action? Unfortunately, Activity Monitor doesn’t 
show you which specific process(es) are contributing to disk activity, 
though in general, high disk activity corresponds to high CPU 
activity, so as a first guess, consider the items using the most CPU 
power. To get all the gory details, open a Terminal window and 
type sudo iotop -oD followed by Return; enter your administrator’s 
password when prompted. You’ll see a display, updated every 
5 seconds, showing the processes accessing your disk most heavily 
(higher numbers in the DISKTIME column mean more disk access 
by that process in the last 5 seconds). To stop iotop, press Control-C. 

Control Spotlight Indexing 
Spotlight is Mac OS X’s system-wide mechanism for indexing and 
rapidly searching files. It was introduced in Mac OS X 10.4 Tiger, 
improved considerably in 10.5 Leopard, and improved still further in 
10.6 Snow Leopard. (As I write this, 10.7 Lion hasn’t been released yet, 
so I can’t say anything about how Spotlight functions there.) 

Some people love Spotlight, and some hate it. I’m not going to ponder 
its many merits and faults in this book, nor do I intend this to be a 
general Spotlight troubleshooting guide. For our current purposes, 
I want to focus on just one aspect of Spotlight: the way it hammers on 
your disk when it’s indexing your files—what that might mean for your 
Mac’s performance, and what to do about it. 

The first time Spotlight encounters a new local disk, it automatically 
reads and indexes the contents of every single file on that disk—a 
process that can take many hours, depending on the number of files 
and the speed of the disk. (By default, Spotlight doesn’t index network 
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Speed Up Your Browser
 
Apart from network issues (which I discuss later, in Speed Up Your 
Network), lots of things can affect the speed with which a browser 
downloads and displays pages (and does other things, too, including 
scrolling and playing videos). This chapter explores some of the 
things you can do to make Web browsing as fast as possible from 
the browser end. 

Quit and Reopen Your Browser
 

Is there an echo in here? Back in Reduce the Number of Open 
Applications, Windows, and Tabs, I told you that you can increase the 
amount of free RAM on your Mac by quitting applications (even if you 
immediately reopen them). I hereby reiterate that advice, but when it 
comes to Web browsers, you may need a bit of additional information 
to help you cope effectively with this strategy. 

If you’re like me, you don’t browse just one Web page at a time. 
Perhaps you do a search in Google and then Command-click a bunch 
of links to open them in background tabs so you can visit them later. 
Maybe you have a set of Web pages you like to visit every day, so 
you keep them open in tabs or in separate windows. Or maybe you 
frequently follow links in your email or Twitter client for sites you’d 
like to explore later, giving you lots of open tabs or windows you 
haven’t explored. Whatever the case, it’s extremely easy to have lots 
of Web pages loaded without even realizing it. Each of those pages uses 
a bit of RAM, and some of them—particularly those that use Flash, 
which I discuss ahead in Manage or Disable Flash—may continue using 
up CPU power when the window or tab, or even your entire browser, 
is in the background. The quickest way to free up all those system 
resources is to quit your browser. 

But wait! Won’t you lose all those open pages when you restart your 
browser? What if you haven’t looked at them yet—or don’t want to go 
to the bother of individually bookmarking them and reopening them? 
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Fear not; I can offer several suggestions:
 

•	 Manually bookmark a group of tabs. In Safari, you can 
choose Bookmarks > Add Bookmarks for These X Tabs to create 
a bookmark folder for all the tabs in the frontmost window. Later, 
you can reopen all those tabs at once by choosing Bookmarks > 
bookmark folder name > Open in Tabs. You can do the same thing 
in Firefox or Google Chrome by choosing Bookmarks > Bookmark 
All Tabs. 

•	 Restore tabs manually after restarting Safari. If you quit and 
reopen Safari, you can choose History > Reopen All Windows from 
Last Session to return all your windows and tabs to their state when 
you last quit Safari—no bookmarking required. 

•	 Restore tabs automatically. Most browsers offer a mechanism 
whereby you can ensure that if you quit the browser and reopen it, 
all your windows and tabs return to their previous states: 

‣	 Firefox: In Firefox, if you quit the browser while tabs or 
windows are open, a “Do you want Firefox to save your tabs for 
the next time you start?” alert appears. Click Save and Quit. The 
next time you open Firefox, it puts everything right back where 
you left it. 

To make Firefox automatically save all your tabs and windows 
and reopen them when you next launch the browser (avoiding 
that alert every time), choose Firefox > Preferences, click 
General, and choose Show My Windows and Tabs from Last 
Time from the When Firefox Starts pop-up menu. 

‣	 Google Chrome: In Chrome, choose Chrome > Preferences, 
click Basics, and select Reopen the Pages that Were Open Last 
in the On Startup section. 

‣	 Safari: Safari doesn’t have a built-in feature to automatically 
restore tabs on relaunch, but you can get this capability by 
installing a free third-party extension such as Sessions by David 
Yoo (http://dl.dropbox.com/u/8247646/sessions/index.html). 

Any of these techniques can make quitting and reopening your browser 
painless enough that you won’t mind doing so if the need arises. Be 
aware, though, that reloading all the pages could take some time, and 
if you’ve navigated deep within a database-driven site or entered data 

109
 

Click here to buy the full 196-page “Take Control of Speeding Up Your Mac” for only $15!

http://dl.dropbox.com/u/8247646/sessions/index.html
http://dl.dropbox.com/u/8247646/sessions/index.html
http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU71198567198&PT=TRK-0119-SAMPLE


              
           

           
            

          
  

 

              
             

       
            

       

            
              

          
           

             
           

            
           

      

            
                 

            

         
           

 

        
          
           

       

Speed Up Your Email
 
In this chapter I talk about some of the things that can make email 
much slower than it needs to be when using desktop clients such as 
Apple Mail and Microsoft Outlook, and how to address those issues. 
But be sure also to read the next chapter, Speed Up Your Network, 
which covers general network issues that could also have an effect 
on your email. 

Adjust Checking Frequency
 

If you depend heavily on the timely receipt of email, you may have set 
your email client to check your IMAP or POP account as frequently as 
possible—say, once per minute. Paradoxically, such frequent checks 
can slow down your email client, in some cases increasing the amount 
of time it takes to receive new messages. 

The reason is that each check takes time; the more accounts you have, 
and the more messages in each one, the greater that time is. If a single 
check takes longer than the interval you’ve designated between checks, 
the result is that your client is perpetually checking for messages. 
Depending on how your client is designed, this may mean that a series 
of checks are queued up such that checking your first account may 
have to wait until your client is finished checking several other, slower 
accounts; or it could mean that multiple checks are happening in 
parallel, which can slow down all of them. 

In any case, my advice is simple: try a longer interval between checks— 
5, 10, or 15 minutes. See how that goes for a day or two; you can always 
adjust it again later. To change the frequency of email checks, do this: 

•	 Apple Mail: Choose Mail > Preferences, click General on the 
toolbar, and choose a frequency from the Check for New Messages 
pop-up menu. 

•	 Microsoft Entourage or Outlook 2011: Choose Tools > Run 
Schedule > Edit Schedules. Double-click the Send & Receive All 
schedule, enter a time in the “Repeating Schedule” row, and click 
OK. Repeat with any additional schedules you may have. 
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•	 Thunderbird: Choose Tools > Account Settings. Under any email 
account in the list on the left, select Server Settings. Change the 
number in Check for New Messages Every __ Minutes and click OK. 
Repeat this for each of your accounts, if you have more than one. 

Consolidate Your Accounts
 

Your email client can check as many different accounts as you have— 
and many of us have quite a few! But checking more accounts takes 
longer, and you can speed up your email by consolidating your 
accounts so that your client has fewer servers to talk to (ideally only 
one). Of course, you may still need to receive mail from multiple 
addresses (say, a work address and a home address) and also send mail 
from multiple addresses (so that replies go to the right place). With 
a bit of effort, you can do all of this while still checking only one email 
account for incoming messages. 

Receiving Email 
If you have multiple personal POP or IMAP accounts, you can choose 
one as your primary account—that’s the one you’ll actively check with 
your email client—and then redirect email from your other (secondary) 
accounts to this primary account. 

There are two ways to do so: 

•	 Set your secondary account(s) to forward all incoming mail to your 
primary account. Or… 

•	 Set the primary account to fetch mail from the secondary account(s) 
using POP (a feature commonly offered by larger email providers) 
or IMAP (much less common). 

Either way, one account ends up with all the incoming mail sent to 
multiple addresses. 

Before deciding which account will be your primary account, research 
the capabilities of your mail server—for example, some email providers 
let you fetch mail from only a single external POP account. Gmail and 
MobileMe, however, can check multiple POP accounts, and can do so 
automatically and continuously, making them good choices to serve as 
primary accounts. 
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Speed Up Your Network
 
What some perceive as a slow Mac has nothing to do with the 
Mac tself, but rather with one or more of the links in the network 
between the Mac and another computer (such as a Web server). In 
this chapter I look at several parts of that chain to help you identify 
and clear bottlenecks. 

This discussion of network speed is deliberately shorter on details 
than most of this book, for two reasons: 

•	 Because of the many variables involved in optimizing a wireless 
network, it would take an entire book to do that topic justice. 
Luckily, for those who use Apple’s AirPort base stations or Time 
Capsule devices, just such a book exists: Glenn Fleishman’s Take 
Control of Your 802.11n AirPort Network, which I heartily 
recommend to you. (In fact, you can learn a lot from that book 
even if you use other vendors’ Wi-Fi products.) 

•	 The last comment notwithstanding, a large percentage of 
network speed issues can be solved readily with a few simple 
tests and tips, which I’m happy to provide in the following pages. 

Understand Factors Influencing 
Network Speed 

Suppose something involving a resource on the Internet seems slow— 
for example, maybe Web pages take a long time to load. This sort of 
thing can be tricky to diagnose, because there may be a great many 
links in the chain between your Mac and the server it’s talking to, and 
any one of them could be the bottleneck. For example: 

•	 Your Mac itself could have network configuration problems. 

•	 Your browser, or a plug-in, might be at fault (as discussed earlier, in 
Speed Up Your Browser). 

•	 A particular process (such as an online backup program) could be 
monopolizing your Internet bandwidth. 
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•	 You could have a bad Ethernet cable. (Seriously!) 

•	 The Wi-Fi connection between your Mac and your AirPort base 
station or other wireless router might be too slow. 

•	 The broadband link to your ISP could be inherently slow, or the ISP 
could be experiencing temporary congestion. 

•	 The DNS servers that map domain names to IP addresses could be 
responding slowly, adding delays to each request you make. 

•	 The server on the other end—or any of the intervening routers, 
switches, hubs, gateways, and other equipment—might be too slow. 

When I Say “Slow…” 

Networking geeks are often quick to reprimand anyone who dares to 
use words like “slow,” “fast,” or “speed” when referring to a network, 
because signal speed per se—the movement of electrons through 
copper wire or photons through optical fiber—isn’t what most people 
are talking about. So what are we talking about? 

On the one hand, you have bandwidth, which is itself a metaphorical 
usage, but now generally refers to the capacity, or maximum possible 
data transfer rate, of a network segment as expressed in (tera-/ 
giga-/mega-/kilo-) bits per second. For example, your DSL 
connection may have a bandwidth of 8 Mbps (megabits per second), 
which means that, in theory, you could download a 1 MB file 
(1 megabyte = 8 megabits) in 1 second. 

However, a more important concept is throughput, which you can 
think of as the real-world data transfer rate (amount of data received 
per unit of time)—invariably a good bit lower than the theoretical 
bandwidth. Your so-called 8 Mbps connection may have throughput 
of only, say, 6 Mbps—and that can vary from moment to moment. 

Although technically neither bandwidth nor throughput is a measure 
of speed, higher bandwidth generally correlates to higher throughput, 
and higher throughput means shorter times for a given amount of 
data to be transferred. In everyday usage, “less time waiting” equals 
“faster,” and “more time waiting” equals “slower.” So there! 

131
 

Click here to buy the full 196-page “Take Control of Speeding Up Your Mac” for only $15!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU71198567198&PT=TRK-0119-SAMPLE


 

            
               

             
          

   
 

              
             

           
           
         

         
         

           
           
           

              
            
            

      

             
          

          

           
            

         
       

          
               

Speed Up Booting, 
Sleeping, and Waking 
In this chapter, I discuss a number of factors that can influence 
how long it takes a Mac to boot. In addition, I explore an issue that 
can significantly affect how long it takes for a notebook Mac to enter 
and exit sleep mode—as well as how much disk space is used. 

Understand What Influences 
Startup Speed 

When you turn on or restart your Mac, it has to read thousands of 
files from your disk, copy a fair amount of data into RAM, and launch 
a number of programs, most of which run invisibly in the background. 
Beyond what Mac OS X itself needs to function, the process may 
include loading third-party software of various kinds, such as kernel 
extensions (which modify Mac OS X’s behavior at a low level) and 
startup items (often helper applications that run in the background). 

Once Mac OS X has started, the login process begins. Depending on 
your preferences (see Cut Back on Startup and Background Items), this 
may happen immediately and automatically, or you may have to supply 
a user name and password to log in. Either way, Mac OS X then loads 
still more files and runs still more programs, including any shown in 
the Login Items list in the Accounts pane of System Preferences (called 
Users & Groups pane in 10.7 Lion). 

All of the above could take less than 30 seconds or more than 
10 minutes—or anywhere in between. What could account for that 
tremendous difference in time? Here are some of the key factors: 

•	 Disk speed: Because so many files must be read, the speed with 
which your disk can transfer data into RAM is key. In general, hard 
disks with lower rotational speeds are the slowest; disk with higher 
rotational speeds are faster; and SSDs are fastest. 

•	 Directory health: Directory is the informal name for a set of 
special files on any disk that that keep track of where all the data is. 
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Because any given file may be stored in dozens or hundreds 
of smaller pieces scattered over the disk, the directory enables 
Mac OS X to find and reassemble all those pieces (among other 
functions). Any number of factors can result in a damaged or 
inefficiently structured directory, which in turn makes it more time-
consuming to locate and read the files necessary to start Mac OS X. 

Geek tip: See technical details of the HFS+ file system at http:// 
developer.apple.com/library/mac/#technotes/tn/tn1150.html. 

•	 Caches: Some of the components that Mac OS X must load at 
startup, including fonts and kernel extensions, are cached to 
provide faster access. Reading caches is faster than reading all the 
individual files—unless the caches are damaged. In situations where 
a cache is outdated or has been deleted, the startup process takes 
longer, both because Mac OS X must read all the individual files 
from scratch and because it must also rebuild and write the cache. 

•	 Startup and login items: Although many startup and login items 
load almost instantly (especially launchd items that don’t necessarily 
run programs when they load—see the sidebar Launchd and the 
Meaning of “Start”), some of these are full-blown applications that 
can take several seconds or more each to open. 

•	 Safe Boot factors: As I explained in Using Safe Mode, holding 
down the Shift key when you start your Mac disables a number 
of things, which sounds as though it should make your Mac boot 
faster. But because a Safe Boot bypasses the cache of kernel 
extensions and also runs a directory check, it typically takes longer 
than a regular boot. In addition, your first regular boot after a Safe 
Boot may take a bit longer as caches are rebuilt. 

Speed Up Startups
 

Although it may be obvious from the foregoing, you can often decrease 
the amount of time it takes to boot your Mac by doing the following: 

•	 Upgrade to a faster hard disk or an SSD; see Upgrade Your Hard 
Drive and Add an SSD. 

•	 Make sure your directory is healthy; see Run Disk Utility. 
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Speed Up Mouse and 
Keyboard Input 
People have written to tell me their Mac is too slow, and on further 
investigation I discovered that what they really meant was that 
their mouse pointer was too slow—an easily solvable problem, 
if you know what to do. This is just one of several cases where 
benchmarking and timed tests don’t tell the whole story, because 
so many factors figure into one’s subjective perception of speed. 

In this brief chapter I tell what to do if your pointer seems slow;
 
I also cover other ways to make your Mac seem faster because you 

can get more done with less mousing and fewer keystrokes, using
 
a variety of utilities.
 

Speed Up Your Pointer
 

You may have noticed that the average mouse pad is a lot smaller 
than the average display. Likewise, if you have a trackpad (either built 
into your Mac or external), you may have noticed that it’s quite a bit 
smaller than your Mac’s display. And yet, you can usually move the 
pointer from one corner of your display to the other in a single motion 
without running out of space! That’s because pointing devices (of 
whatever sort) don’t have a one-to-one correspondence between 
distance moved physically and the distance your pointer moves on 
screen. To save wrist movement and disk space, your pointing device 
can translate small physical movements into larger virtual distances. 

However, it’s not a fixed ratio (as in, 1 inch of mouse movement 
equals 3 inches of pointer movement on the screen). Sometimes 
you want to be able to move your pointer a tiny amount, and if the 
mapping were linear, it would be terribly difficult to control. So Mac 
OS X, like all operating systems, builds in an acceleration curve, a 
mathematical model that basically says, if your mouse is moving 
slower, the pointer should travel smaller distances, and if it’s moving 
faster, it should travel larger distances. In practice, most of us 
instinctively move the mouse faster when we want the pointer to travel 
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large distances, and are never even conscious of the acceleration effect, 
but trust me: you’d miss it if it were gone! 

Depending on such variables as the type of pointing device you use, 
the size of your hands, the size and resolution of your display, the type 
of work you’re doing, and what you’ve become accustomed to, you may 
find the default mouse settings uncomfortable—the pointer movement 
may seem too slow, too fast, or too unpredictable. (Former Windows 
users who have recently moved to the Mac often fall into the “this 
mouse feels awful!” camp.) 

Apple includes a slider that lets you adjust “tracking speed,” and 
that’s an easy thing to try first, but it may or may not do the trick for 
you. That’s because what Apple refers to as tracking speed amounts 
to a simplistic scaling of the acceleration curve (making pointer 
movements uniformly larger or smaller in proportion to distance 
moved), but not changing the basic shape of the curve—the rate and 
extent of change in the pointer’s speed based on the mouse’s speed. 
To do that, you’ll need third-party software. 

Adjust Tracking Speed 
To make basic adjustments to your pointer speed, all you need do is 
move the Tracking Speed slider left (slower) or right (faster). The trick 
is finding that slider! Here’s where to look: 

•	 Mouse: If you have a mouse, you configure it the Mouse pane of 
System Preferences (in Mac OS X 10.6 Snow Leopard or later) or 
the Mouse view of the Keyboard & Mouse pane (in 10.5 Leopard 
and earlier). 

•	 Trackpad (newer): If you have a Mac notebook released in 
October 2008 or later featuring a glass multi-touch trackpad 
without a separate button, or an Apple Magic Trackpad, you 
configure the trackpad in the Trackpad pane of System Preferences. 

•	 Trackpad (older): If you have a Mac notebook with the older-
style trackpad, you configure the trackpad in the Trackpad view 
of the Trackpad pane (in Snow Leopard or later) or the Keyboard 
& Mouse pane (in Leopard and earlier). 

If you have a third-party pointing device, see the sidebar Preferences 
for Third-Party Input Devices, ahead page or two. 
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Upgrade Your Hardware
 
Fiddling with the applications and files on your disk can solve many 
problems that decrease your Mac’s performance, but if you want to 
actually make your Mac faster than the day you bought it, you may 
need to undertake some hardware modifications. These range from 
easy and inexpensive (yet incredibly effective) to expensive and 
scary (while not so effective). But if you’re serious about speed, 
you’ll almost certainly do at least some of these things. 

Add RAM
 

I’ve mentioned RAM many times in this book because the correlation 
between free RAM and speed is so strong. By now I hope I don’t have 
to convince you how valuable it is, but you may still be wondering how 
much RAM to add, where to get it, and how to go about installing it. 
Allow me to address these questions briefly. 

How Much? 
As of 2011, the lowest amount of RAM any Mac ships with is 2 GB. 
In my opinion, that’s far too little for almost anyone. Mac OS X itself 
uses so much RAM that you’ll be severely restricted in how many 
applications and files you can open before virtual memory begins 
paging memory to disk, thus slowing you down significantly. On the 
other hand, some of today’s Macs hold a maximum of 4 GB; a few early 
Intel-based Macs held a maximum of 2 GB; and some PowerPC-based 
Macs still likely to be in service held a maximum of only 1 GB. 

A bit more or less: You may have heard the term “64-bit” bandied 
about as being the latest thing in hardware and software. For our 
current purposes, all you need to know is that if your Mac is not 64-
bit capable, its maximum RAM capacity can be no more than 4 GB. 
Apple began shipping Macs with 64-bit architecture in late 2006. 

At the other end of the spectrum, high-end Mac Pro models hold as 
much as 64 GB of RAM. Based on today’s software, very few people 
can productively keep that much RAM busy, which is fortunate 
because very few people can afford that much RAM! 
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For most people and most common activities, I believe something in 
the range of 6 to 16 GB should be sufficient. At those quantities, RAM 
is fairly inexpensive compared to the price of a new Mac, and the 
incremental cost of an extra 1 or 2 GB is usually quite small. So it pays 
to add as much as you can, within reason. 

Pairing up: Intel-based Macs get a slight performance boost when 
RAM modules are installed in matched pairs—that is, pairs of the 
same size. If you have an odd number of modules, or modules of 
different sizes (say, a 2 GB module and a 4 GB module), performance 
will be a tiny bit slower, but the speed boost from having a greater 
quantity of RAM virtually always trumps what you get from matched 
pairs of a smaller quantity. 

All that said, here are my specific suggestions: 

•	 If your Mac has a capacity of 8 GB of RAM or less, install the 
maximum it can hold. 

Out of thin Air: The MacBook Air is the only Mac model that 
lacks support for adding RAM after the fact; the only way to get 
more than the base amount is to request it as a build-to-order 
option. 

•	 If your Mac has a capacity of 16 GB and you can afford it, install 
16 GB; otherwise, give it at least 8 GB. 

•	 If your Mac has a capacity of 32 GB or more, install at least 16 GB. 
Go above that only if you learn from Activity Monitor or other tools 
that you’re generating significant quantities of pageouts—and you 
can afford it! If you’re doing massive scientific calculations or high-
end, high-definition video editing, you may very well benefit from 
64 GB of RAM. Most ordinary folks, however, will seldom max out 
more than 16 GB. 

•	 If you buy a new Mac, check to see not only how much RAM it 
includes but how the modules are configured. If you plan to upgrade 
your RAM later, it helps to know whether you’ll have to replace any 
of the existing modules to get to your desired total. (If you order 
your Mac from the online Apple Store, the configuration page shows 
you this information.) Sometimes Apple gives you the choice—for 
example, 8 GB in the form of four 2-GB modules or two 4-GB 
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Speed Up Your Peripherals
 
USB and FireWire are the most commonly used interfaces for 
the sorts of external devices (such as hard drives) that can most 
significantly affect your Mac’s speed. In this final chapter I get into 
some admittedly geeky territory, discussing somewhat obscure 
concepts such as bus bandwidth and hub power supplies. But it’s all 
in the service of speeding up your Mac. By understanding what I 
explain here, you can make informed decisions about which devices 
to connect to your Mac and how to do so in a way that keeps overall 
performance as high as possible. 

Learn about Buses and Ports
 

If you look at your Mac, you’ll see one or more USB ports (physical 
connectors where you can attach USB cables) and perhaps one or 
more FireWire ports. (There are others, too, such as ports for video 
and Thunderbolt, but for the purpose of this chapter I’m concerned 
only with USB and FireWire.) 

It’s fairly obvious that if you have three USB ports, you can plug 
in three USB devices. (And, if one of those devices is a hub, which 
increases the number of available ports, you can plug in still more 
devices.) All the ports of a given type look the same, but details about 
your Mac’s internal configuration could determine which of those 
ports you might want to attach a device to. 

To make sense of this, you must understand the concept of a bus, 
which is essentially a particular set of physical circuits that carry some 
sort of data. Your Mac has many different buses for communicating 
with a variety of internal and external devices, and ordinarily you need 
never concern yourself with any of them. However, there’s a crucial 
fact about buses that can impact your Mac’s performance: every bus 
has a fixed amount of bandwidth, which is to say that no matter how 
many devices connect to it, only a certain amount of data can travel 
through the bus at any given time. So, if a bus has just one device on it, 
that device can use the bus’s full bandwidth. Connect two or more, and 
the devices must share that bandwidth. Of course, all the devices may 
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not actively be transferring data at any point in time, but to the extent 
that they do, the bus bandwidth can limit their effective speed. 

Now here’s the interesting part: The number of USB or FireWire buses 
your Mac has may be completely different from the number of ports it 
has! For example, your Mac may have only one USB port but two USB 
buses (the second of which is used for internal devices such as the 
trackpad and camera). Or it may have more USB ports than buses, 
meaning each bus shares multiple ports. Or it may have two FireWire 
ports (say, a FireWire 800 and a FireWire 400) connected to the same 
internal FireWire bus. 

Note: Among the internal devices that may connect to a USB bus are 
your keyboard and trackpad (on a notebook Mac), iSight or FaceTime 
camera, Bluetooth controller, IR receiver, and SD card reader. 

Why should you care about this? It’s simple: knowing that each bus 
has a limited amount of bandwidth, you’ll get the best performance if 
you spread out the load. For example, let’s say you have two USB hard 
drives and two USB ports on your Mac, which you’ve discovered (as 
I explain in a moment) correspond to two different USB buses. You 
could connect one drive to each port, or you could connect a hub to one 
of the ports and connect both drives to the hub (leaving the other port 
free for additional devices). In this example, connecting one drive to 
each port is generally the better choice, because then they don’t have 
to share the bandwidth of a single bus. If you need to attach more 
devices, you can still use a hub, plugging one of your drives (and the 
other devices) into it, but keeping that on a separate USB bus from the 
other drive will increase the performance of both. 

So… how can you figure out how many buses your Mac has, and which 
ports go with which buses? Follow these steps: 

1. Open System Profiler (in /Applications/Utilities). 

2. In the list on the left, under Hardware, select USB (Figure 15). 
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About This Book
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. 

Ebook Extras
 

You can access extras related to this ebook on the Web. Once you’re 
on the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
a subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and—usually— 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

•	 Read postings to the ebook’s blog. These may include new 
information and tips, as well as links to author interviews. At the 
top of the blog, you can also see any update plans for the ebook. 

•	 Get a discount when you order a print copy of the ebook. 
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Joe Kissell is Senior Editor of TidBITS, a Web site and email 
newsletter about Apple and the Internet, and the author of numerous 
print and electronic books about Macintosh software, including Take 
Control of Mac OS X Backups and Take Control of Maintaining Your 
Mac. He is also a Senior Contributor to Macworld, was the winner 
of a 2009 Neal award for Best How-to Article, and has appeared on the 
MacTech 25 list (the 25 people voted most influential in the Macintosh 
community) since 2007. Joe has worked in the Mac software industry 
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development for Nisus Software and Kensington Technology Group. 
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In his increasingly imaginary spare time, Joe likes to travel, cook, walk, 
and practice t’ai chi. He lives in Paris with his wife, Morgen Jahnke, 
their son, Soren, and their cat, Zora. 

To contact Joe about this book, send him email at jwk@me.com and 
include Take Control of Speeding Up Your Mac in the subject so his 
spam filters won’t intercept it. Better yet, if appropriate, post your 
question publicly in our forums at http://www.getsatisfaction.com/ 
takecontrolbooks/. 
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